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1. ORDERING GUIDE

Configure a model number in this format: T20201DCV1, CBLO1

....Digital panel meter with
screw terminal connectors.

L Display Color

3 DPM with green LED
2 DPM with red LED
3. Extended DPM, green LED
4....... Extended DPM, red LED

Note: Extended adds rate of
change & linearization of non-
linear inputs. Not applicable to
thermocouple, RTD or resist-
ance inputs.

Power

O None
1 Two 8A contact relays
2. Two solid state relays
3. Four 8A contact relays
4o Four solid state relays

— Analog Output

O None
T RS232
2 e RS485
4o, RS485-Modbus
D USB
ST USB toRS485 converter
Input Type

DC Volts

DCV1....ooovveeeiiiin 200.00 mV
DCV2...cooeiiiiieeeeeen, 2.0000 V
DCV3..oeeeeieeeeee, 20.000 V
DCVA.....ooveeiiiieeeaaenn, 200.00 V
DCV5* ..o, 600.0 V
DCVB....oooeeeeeeeeeeeeeeeen, 300.0V

* Range not UL approved.

DC Amperes

DCAL oo, 2.0000 mA
DCA2 .., 20.000 mA
DCAS3 .. 200.00 mA
DCA4 ... 5.000 A
RTDs

P385C ... Pt100, -202 to 850°C
P385F...Pt100, -331 to 1562°F
P392C. .. Pt100, -202 to 850°C
P392F...Pt100, -331 to 1562°F
N672C... Ni120, -202 to 850°C
N672F ..Ni120, -331 to 1562°F
C427C. ...Cu10, -202 to 850°C
C427F ...Cu10, -331 to 1562°F

Thermocouples

N | ORI -210 to 760°C
N | S -347 to 1400°F
(O -244 to 1372°C
KF o, -408 to 2501°F
TC e, -257 to 400°C
B ST -430 to 752°F
EC .o -240 to 1000°C
EF ., -400 to 1830°F
NC.ooorriieeees -245 to 1300°C
NF e, -410 to 2370°F
SC e, -46 to 1768°C
SF. -51 to 3214°F
RC.oooeeeeeeeen, -45 t0 1768°C
RFE o, -49 to 3213°F
Resistance / Ohms

Rl.ooiiinniis 0 to 20.000 ohms
R2.iiin. 0 to 200.00 ohms
R3..n, 0 to 2.0000 kohms
R4.............. 0 to 20.000 kohms
RS, 0 to 200.00 kohms

Process Signals
(4-20 mA, 0-10V, etc.)

P, 4-20 mA = 0-100.00
Pl................ Custom Scaling

Specify min signal & reading,
max signal & reading.

Strain Gauge, Potentiometer
(4-wire ratio)

SG......... 0-200 mV = 0-100.00
SGl...eeee. Custom Scaling

Specify min signal & reading,
max signal & reading. Full-
scale ranges 200 mV to 20V.

RMS Volts

RMV1.................... 200.00 mV
RMV2 ... 2.0000 V
RMV3 ..., 20.000 V
RMV4 ... 200.00 V
RMV5* i 600.0 V
RMVG .......coovvviiiiinnnn 300.0 V
RMS Amperes

RMAL ... 2.0000 mA
RMAZ ... 20.000 mA
RMA3.........coee 200.00 mA
RMA4 ..o 5.000 A

Load Cells (6-wire ratio)
WML1......... -99,999 to +99,999

Specify min input signal & dis-
played reading, and max input
signal & displayed reading.
Full-scale inputs 20 mV to 500
mV. 10 Vdc excitation.

Options & Accessories

BL......... Blank lens, no button
pads.
CBLO01.. RJ11-to-DB9 RS232

cable. Connects me-
ter to PC com port.
.. USB-to-DB9 adapter.
For use with CBLO1.
.. USB-cable. Type A
male to Type B male.
IPC....... NEMA-4 panel cover.

BOX1.... NEMA4 wall mount
enclosure.
BOX2.... BOX1 plus IPC.
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3. PRODUCT INTRODUCTION

These UL-certified digital panel meters are versatile, cost effective solutions to a wide variety
of monitoring and control applications. Depending on the choice of signal conditioner, they are
easily set up for an accurate display of temperature, pressure, flow, weight, voltage or current,
all in appropriate engineering units and with zero and span adjustment when needed. Setup
can be via front panel pushbuttons or the meter’s serial interface. Selective security lockout of
the front panel keys protects against accidental changes to meter setup.

High read rates up to 60 per second (50 for 50 Hz operation) are made possible by Concurrent
Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power line cycle for
maximum noise rejection. High read rates provide accurate peak and valley capture, and quick
response for control applications. An adaptive digital filter supplies a time constant for the
encountered signal noise level, yet responds rapidly to changes that exceed a selected
threshold. Self-calibration occurs automatically after every 17th reading.

The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or from 12-30 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output.

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted (not verified for UL
certification). Mounting is from the front of the panel and requires less than 110 mm behind the
panel. Power and signal wiring is via removable plugs conforming to UL61010C safety
standards. All output options are isolated from meter and power ground to 250 Vac.

Extended meter versions can linearize nonlinear inputs. Up to 180 data points may be
linearized by a computer program that stores setup parameters in nonvolatile memory.
Extended meters can also display rate of change, for example to display flow rate based on
changing tank level.

Alarm or setpoint control is provided by an optional relay board with two or four Form C 8A
mechanical relays or two or four Form A 130 mA solid state relays. The setpoints may be
latching or non-latching, be energized above or below the setpoint, or operate in a fail-safe
mode. The relays can operate from the filtered signal to reduce relay chatter or from the
unfiltered signal for fastest response. Snubber circuits and a programmable relay switching
time delay extend relay contact life.

An isolated analog output of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an
optional analog output board. The output is linearized to the display and can operate from the
filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the meter’s
serial interface.

USB, RS232, or RS485 (2-wire half-duplex or 4-wire full-duplex) serial communications options
are available with Series 2 meters utilizing the Modbus protocol or a simpler custom ASCII
protocol. Modbus operation includes RTU or ASCII modes, up to 247 digital addresses, and up
to 32 devices per RS485 line without a repeater. A USB-to-RS485 converter board allows a
meter to be interfaced to a PC and to multiple meters on an RS485 network.

Meter programming can be via the meter’s front panel or a PC running Windows based
Instrument Setup Software (serial interface option required).
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4. RECEIVING & UNPACKING

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

A Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify
that the proper power option is installed for the power to be used. This meter has no AC
(mains) switch. It will be in operation as soon as power is connected.

The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored
Black.

Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.

Verify the panel cutout dimensions, and mount according to instructions.

Symbols used

A Caution (refer to accompanying documents) J_— Earth (ground) terminal.

A Caution, risk of electric shock. /" Both direct and alternating current.

] Equipment protected throughout by double

insulation or reinforced insulation.

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



6. CONNECTOR WIRING INFORMATION

CONNECTORS

Connectors for signal and power are UL-rated

screw-clamp terminal blocks that plug into
mating jacks on the printed circuit board.
Communication connectors are a single RJ11
plug for RS232, dual RJ11 plugs for RS485,

dual RJ45 plugs for RS485 Modbus, or USB.

P1 - POWER AND DIGITAL CONTROLS

ACHI (+DCHI)
AC NEUTRAL (DC RET)
EARTH GROUND

CONTROL INPUT 2 (+5V OUT)*
CONTROL INPUT 1*
DIGITAL GROUND

Warning: Hazardous voltages may be present
on pins 4, 5 & 6 of P1 since digital ground is tied
to pin 3 of P5 (-Signal Input). Keep pin 3 close to
earth ground to minimize common mode voltage
or shock hazard at pins 4, 5 & 6 of P1.

[=l=1=|y]=]=l=

DNk Wk =

PS - SIGNAL INPUT

DC 8 PROCESS
Signal Source

-EXCITATION 1m0t — T— n
+EXCITATION 2L EB—"=—— — —+

- SIGNAL INPUT 3[ X |7 " ot

+SIGNAL INPUT 4| [IT *

2WIREPROCESS TRANSMITTER
Signal Source

224V EXCITATION 1] m
+24V EXCITATION 2! A ¥
-SIGNAL INPUT 3[E -
+SIGNAL INPUT 41 EX| !
STRAINGAUGE
1OVEXCITATION 1] D
+10V EXCITATION 2| |
SIGNAL 3o
+SIGNAL 4| XX

AC (TRUE RMS)

SIGNAL HIGH 1] mmf—2,20,200, 600V INPUTS
NG 20 A

SIGNAL LOW 3[ o |~ AC NEUTRAL

SIGNAL HIGH 4LELf 0.2V, CURRENT INPUTS

Note: Control inputs 1 & 2 of P1 are menu
selectable.

LOAD CELLMETER

-10 V EXCITATION 1

-SENSE 2
-SIGNAL 3
+SIGNAL 4

+10 V EXCITATION 5

+SENSE 6

=] 1= =

RTD & OHMS (2-WIRE)

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

|5E|IEE

LT

RTD & OHMS (3-WIRE)

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

RTD & OHMS (4-WIRE)

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

THERMOCOUPLE

1
2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

i

L
i
Ty

[ >




P2 - SETPOINT CONTROLLER
DUAL MECHANICAL RELAY OUTPUTS

ALARM 1 N/OCONTACT
ALARM 1 COMMON

ALARM 1 N/CCONTACT

ALARM 2 N/OCONTACT
ALARM 2 COMMON
ALARM 2 N/CCONTACT

EEH|[EES

QUAD MECHANICAL RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARM2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON

DUAL SOLID STATE RELAY OUTPUTS

ALARM1 1| mm— DCORAC
ALARM1 2| [ME|— NOTUSED
ALARM1 3L IEHi— DCORAC
ALARM?2 4| mm[— DCORAC
ALARM2 5| I — NOTUSED
ALARM?2 6| [lll— DCORAC

QUAD SOLID STATE RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARM2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON

EEE|EEE

ALARM4 N/OCONTACT ALARM4 N/OCONTACT

EEE| EEE

P3 - SERIAL COMMUNICATIONS P4 - ANALOG OUTPUT

UNIPOLAR CONNECTIONS

RS232 INTERFACE Computer 4-20 mA or 0-20 mMAOQUTPUT 1] hm
0-10V OUTPUT 2| [m
oD ISOLATED GROUND 3| XX
TX BIPOLAR CONNECTIONS
§>T<S REFERENCE or RETURN 1] [m
10V to +10V OUTPUT 2| I
N/C 3| [

RS485 INTERFACE - FULL DUPLEX RS485 INTERFACE - HALF DUPLEX

ISO GND GND ISO GND 6 - GND

BRX BTX 5 mmm

ARX ATX 4 wmm

ATX ARX ATX / ARX 3 o ATX / ARX
BTX ARX BTX / BRX 2 mmm BTX / BRX
ISO GND GND ISO GND 1 — GND

RS485-MODBUS - FULL DUPLEX RS485-MODBUS - HALF DUPLEX

(A") RXDO - TXDO 1 w—
(B) RXD1 + 2 TXD1 e
3 3
(B) TXD1 * 4 RXD1 (B) TX/RXD1 pp— (B) TX/RXD1
(A) TXDO - 5 RXDO (A) TX/IRXDO 5 m— (A) TX/RXDO
6 m=m 6 m=m
7 . 7 =
ISO GND 8 GND ISO GND g = GND




7. MECHANICAL ASSEMBLY I

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

Retaining tab —

with tab release

¥—_ Retaining tab

with tab release

Retaining tab

— Retaining tab
Rear Panel
REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-

tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may be installed in the field. They will be recognized by the software, which will
provide access to the menu items associated with that board. If necessary, remove rear
panel knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Plug Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5




Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, and then carefully
align the board connectors with the openings in the rear panel. If necessary, remove any
rear panel knockouts for new option boards that may have been installed. Ensure that all
option boards are properly aligned with the molded board retaining pins on the inside of the
rear panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal

plugs.

PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

FRONTVIEW REAR VIEW

P2 P3 P4 P5

(3.78in)
5mm
(0.197in)£ TOPVIEW SIDEVIEW
r l
- .'
K'\‘Mounting Pawl
102mm
{4.02in) PANELCUTOUT
45 +0.6/-0.0mm
(1.772 +.024/-0.0in)
10mm
v v (0394n)

92 +0.8/-0.0mm
I (3.622 +.032/-0.0in)

Dimensioned case drawings



8. FRONT PANEL SETUP KEYS

Alarm status
indicators
1 through 4

MENU key : | q—ALARI’\HS key (reverse MENU)
i RESET key (value select)
PEAK key (digit select)

Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols (k= right arrow,
» right triangle, A up triangle, 4=l left arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters as received from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. That jumper needs to
be removed for the Menu Mode to work, and menu items under Loc 1, Loc 2 and Loc 3 then
need to be set to "0" via the front panel for these menu items to be unlocked See Section 9.
The paragraphs below assume that all menu items have been unlocked.

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

MENU
R

RESET

A

ALARMS
<l

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be
displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again returns the display to the present value. The PEAK key
can also be programmed to display Valley, alternating Peak or Valley, or to Tare the
reading to zero. When Peak or Valley is selected, periodic horizontals bars at the top of
the display indicate Peak, and periodic horizontals bars at the bottom indicate Valley.

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter reset (same as power on). Meter reset can also be applied via a rear panel
connect or a serial ASCIl command.

ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.

KEYS IN MENU MODE

10



MENU
R

RESET

ALARMS

Right Arrow Key (MENU). Pressing l= steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the DC signal conditioner
board and no option boards, available menu items are [Jliat, H2tls. ©90=zc, ISR,

SENE, SONNE, ST, [, WY, I If a change has been made to a menu

item, that change is saved to non-volatile memory when the l= key is pressed next,
and is displayed briefly.

Right Triangle Key (Digit Select).

e Pressing P from the InPut menu brings up all meter functions available with the
meter's signal conditioner. For the DC signal conditioner, these are |JEIeKS],
and

e Pressing » from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:
00000000008

e Pressing » from the dEC.Pt menu item sequentially selects decimal point positions,
which will flash: [sKefe[ele| s[eKe[e[e| e[e[eHele| e[e[e[cle (s[e[e[es[cH Kele[e[ofe|.

Up Triangle Key (Value Select). Pressing A for a flashing item (digit position or
decimal point position) will increment that item. Pressing MENU will save any changes.

Left Arrow Key (Reverse Menu). Pressing «=ll has the same effect as the MENU key,
except that menu items are brought up in reverse order.
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9. ENABLING & LOCKING OUT MENU ITEMS

For security reasons and ease of meter operation, any and all menu J1

items may be disabled or "locked out" so that they are no longer
directly accessible from the front panel. Each function to be disabled
is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and each function
to be enabled is set to "0." The top menu items Loc 1, Loc 2 and Loc
3 can in turn be locked out by installing an internal hardware jumper.
With the jumper installed, the operator only has access only to
enabled menu items. With the jumper removed, the operator also

has access to menu items Loc 1, Loc 2 and Loc 3.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section 9
and locate jumper “a” in the lower portion of the power supply board

next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS

When setting up the meter, it may be necessary to
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout
digit to "1" if you do not want the menu item to be
changed by an operator.

Press the =% MENU key until Loc 1, Loc 2 or Loc 3
is displayed, as desired. Note: the hardware lockout
jumper must be removed (see above).

11111

Press P to display the lockout status, consisting of
1’s and 0’s. The left digit will flash. Press P again to
step to the next digit, which will flash.

00000
12345

Press A to set the flashing digit to "0" to enable the
menu item or to "1" to disable. Press MENU to enter.
See the table to the right for list of menu items that
can be enabled or disabled.

12
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Enabled or Disabled
Menu Items

Loc 1

1 - Input type selection.

2 - Meter setup, configuration
& decimal pt.

3 - Filter selection.

4 - Scale or Lo, Hi input.

5 - Offset or Lo, Hi reading

Loc 2

2 - Alarm setup.

3 - Alarm setpoint value
programming.

4 - Analog output scaling.

5 - Serial interface setup.

Loc 3

2 - View peak value

3 - View alarm setpoints

4 - Reset (peak & latched alarms)
5 - Reset (meter reset)




10. READING COORDINATES OF 2 POINTS SCALING METHOD

When the reading coordinates of 2 points scaling method has been selected under S2{il.
the four menu items below will appear ahead of all other menu items when the MENU or
k=) ey is first pressed from the run mode.

This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a pressure transducer at zero pressure, and high signal, such as the
output of the same transducer at a known high pressure, are applied to the meter. The
desired corresponding low and high readings are then entered from the front panel. The
meter then applies straight line fit between the high and low calibration points. This scaling
method has the advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. This method is ideal for
process and load cell meters, which require zero and span adjustment. It is also available
for DC or AC meters. It is not available with thermocouple or RTD meters.

The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.

Press Menu Select Press Digit Select

MENU
R

Key

Key

Press Value Select
A Key

Apply low signal input
(e.g., transducer output for 0

psi).

Press P to display
reading at low signal input
(e.g., 4.021 mA).

oAl Press A to store low
reading.

Apply high signal input
(e.g., transducer output for
known 100.00 psi source).

PSR! Press P to display
reading at high signal input
(e.g., 20.094 mA).

P)[0ReY! Press A to store high
reading.

Lo rd
Mode to enter desired low
reading (e.g., 0.00).

000.00m000.00m000.00
000.00m000.00RST=Il=Te1 Ko o1

to flash.

BN select B thru [§ for
flashing first digit, [§] thru [ for
other flashing digits.

Hi rd
Mode to enter desired high
reading (e.g., 100.00).

000.00m000.00m000.00
000.00m000.00RST=1l=Te1 Ko o1

to flash.

Ny Select B thru g for
flashing first digit, [§] thru [ for
other flashing digits.

13




11. DC VOLTS, AMPS, PROCESS, STRAIN INPUT

The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (16), analog output (17), communications (18), and transducer excitation output
(19).

Voltage Ranges

FS Input E1 E2 E3

+200.00 mV A
+2.0000 V A
+20.000 V B
B
B
B

+200.00 V
+300V (UL)
+600V (not UL)

QQ T T —h —

Current Ranges

FS Input E1 E2 E3
+2.0000 mA A e, g b
+20.000 mA A d, g b
+200.00 mA A ¢ g b
+5.000 A A | abg]| b

1. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
2. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
3. Store spare jumpers on an unused jumper post not associated a capital letter.

SCALE & OFFSET SETUP

For DC voltmeters & ammeters, a scale factor of 1 and an offset of 0 are used for direct
readings in (milli)volts or (milli)Jamperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 pA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.

For process & strain meters, scaling is normally set up from the front panel using the P and
A Kkeys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Only menu items
applicable to the selected method will be presented.

14



KEYSTROKES FOR SETUP

If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Y 9 Key
20.0UQ200.0Ul600.0U
Selection of signal | DC Volts 0.2, 2, 20, 200, 660V FS
nput type & range 200,02
DC Amps 0.2, 20, 200 mA, 5A FS
20.0U
Strain gauge & ratio 0.2, 2, 20V FS.
SEtuP 00 00 B 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (+99,999)
scale factor of 1. ¥ 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 [l 1=Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) | 1=Hold, 2 = Tare
False = logic 0 (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1= Tare, 2 = Reset
@ 1=1,2=1, decimal point = XXXXX
1=0, 2=1, decimal point = XXXX.X
1=1,2=0, decimal point = XXX.XX
1=0, 2=0, decimal point = XX.XXX
1 =1, 2 =1, decimal point = XXXX.X
1=0, 2=1, decimal point = XXX. XX
1=1,2=0, decimal point = XX.XXX
1=0, 2=0, decimal point = X.XXX.X
B 1 = Function Reset, 2 = Display Blank
B 1 =Hold, 2 = Display Blank
A 1 =Peak or Valley, 2 = Display Blank
[ 1 =Tare, 2 = Display Blank
1 = Valley Display, 2 = Peak Display
[ 1 =Tare, 2 = Reset Tare to Zero

Both inputs 1 and 2 set to logic 1 for selec-
tions @, B, I\, [@ = Function Reset

Both inputs 1 and 2 set to logic 1 for selec-
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Press Menu H Press Digit 3y Press Value Select
amd Select Key Select Key A ICY
000 0 B Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
(0 0 [ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 O B Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O @ Linearinput
Nonlinear input scaling Custom curve linearization
Extended meter only.
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 B Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 [ Display batch average every 16 readings
Display filtering Display filtered signal
BN Adaptive filter |8 Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
 Moving average, 9.6 sec.
B Unfiltered
dEc.Pt d.dddd d.ddddgdd.dddjgddd.ddldddd.dddddd.
Dec. point selection | Decimal point flashes. | IREElle] Press A to shift the decimal point.
Press Menu H Press Digit Press Value Select
amd Select Key Select Key V' 9 Key
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Scaling method “Scale and Offset” if selected under

SCALE PXLLs) CNONNN BNOINEls | Select B thru [§ for flashing first digit, [§] thru g
Scale factor Xolo ol [sMorelols [aMerenaye | for other flashing digits. Select decimal point
Select digit to flash location when decimal point is flashing.
OFFst PXLLs CNONNN BNEIls | Select B thru [§ for flashing first digit, [§] thru [§
Offset value 0.0000§0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by SR

Scaling method “Coordinates of 2 points” if sel

ected under NS0l

PRl [ANeTelele] GNOTeNeS | Select X thru [ for flashing first digit, [§ thru
Low signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLLs CNONNN BNIls | Select B thru [§ for flashing first digit, [§] thru g
Desired reading at | [(JoQaJels] [ONOTeJeJe! for other flashing digits. Decimal point is set

Lo In. Select digit to flash. | by EIESHal

Hi In PXLlY ONelelel GNOIeNNE | Select B thru [ for flashing first digit, [§ thru

High signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

PXLLe CNONNN NeINls | Select K thru [§ for flashing first digit, [§] thru [§

Desired reading at | (Jo[efels ONeJeJofe! for other flashing digits. Decimal point is set

HiIn. Select digit to flash. SYdEC.Pt

Scaling method “Reading coordinates of 2 points” if selected under

Low signal input. Apply a low reference

signal to the meter.

Press A to store the low signal input in the
meter.

20.094
Apply a high reference
signal to the meter.

i In
igh signal input.

e T

Press A to store the high signal input in the
meter.

Lord 0.000080.000080.0000MR0.0000,

Desired reading at | fYee SNl Select K¢ thru g for flashing first digit, ] thru

Lo In. Select digit to flash. for other flashing digits. Decimal point is set
J MG EC.Pil

0.00000.0000[§0.0000§§6.7500

Desired reading at | fYelel SXolN Select K¢ thru g for flashing first digit, §] thru

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

SRdEC Pl

Option board dependent menu items

1

7




Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section16.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including JJIiIER. Decimal point is set by K[=oHzt.
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12. LOAD CELL & MICROVOLT INPUT

The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to £20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (16),
analog output (17), communications (18), and transducer excitation output (19).

RANGE SELECTION VIA JUMPERS

. : b c

Ranges & Display with - :
Scale Factor =1 H | I
Input Jumpers g;l;);ilale - a d

20 mV e +20000 - . =

50 mV | a +50000 e ~
100 mV b +10000 I e
1250 mV c +25000 .
500 mV d +50000

Notes 1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP

For DC microvolt meters, a scale factor of 1 and an offset of 0 are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 uyV. The decimal point is set
separately.

For load cell applications, scaling is normally set up from the front panel using the » and A
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Please
see the Glossary for an explanation of each method.
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KEYSTROKES FOR SETUP
If the MENU I= key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu
amd Select Key

E Press Digit
Select Key

Press Value Select
A Key

Selection of signal
input type & range

%))
~—+
-
>

Strain or ratiometric

20, 50, 100, 250, 500 mV FS voltage

DC millivolts 20, 50, 100, 250, 500 mV FS voltage
SEtuP 00_00 [ 4-1/2 digit meter, counts by 1
Meter Setup Display type 5-digit remote display (+99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 Il 1 =Reset, 2 = Meter Hold
Rear connector control 1 = Function Reset 2 = Pk or Valley Disp.
inputs 1 & 2. 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 = Tare
tied to digital ground) 1= Peak or Valley 2= Tare
False = logic 0 (5V or 1=Tare 2= Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2=1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2=0, decimal point 2 = XXXX.X
1=1,2=0, decimal point 2 = XXX.XX
1=0, 2=1, decimal point 2 = XX. XXX
1=1,2=1, decimal point 2 = X.XXX.X
B 1 = Function Reset 2 = Display Blank
& 1=Hold 2 = Display Blank
I\ 1= Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1="Tare 2 = Tare Reset

Both control inputs 1 & 1 set to 1 for selec-
tions @, B, I, [@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-

tions [, 1 B, &, & [ [E], B = Meter Reset.
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Press Menu E Press Digit Al Press Value Select
amd Select Key Select Key V' 9 Key
ConFG 000 0 B Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
000 O [ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 O [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 0 @ Linearinput
Nonlinear input scaling Custom curve linearization
Extended meter only.
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 [l Display batch average every 16 readings
Display filtering Display filtered signal
BN Adaptive filter |8 Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec.
g Unfiltered
d.dddd dd.dddfiddd.ddfidddd.dffddddd.
Dec. point selection | Decimal point flashes. -
=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
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Scaling method “Scale and Offset” if selected under

SCALE PXLLs) CNONNN BNOINEls | Select B thru [§ for flashing first digit, [§] thru g
Scale factor Xolo ol [sMorelols [aMerenaye | for other flashing digits. Select decimal point
Select digit to flash location when decimal point is flashing.
OFFst PXLLs CNONNN BNEIls | Select B thru [§ for flashing first digit, [§] thru [§
Offset value 0.0000§0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by SR

Scaling method “Coordinates of 2 points” if sel

ected under NS0l

PRl [ANeTelele] GNOTeNeS | Select X thru [ for flashing first digit, [§ thru
Low signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLLs CNONNN BNIls | Select B thru [§ for flashing first digit, [§] thru g
Desired reading at | [(JoQaJels] [ONOTeJeJe! for other flashing digits. Decimal point is set

Lo In. Select digit to flash. | by EIESHal

Hi In PXLlY ONelelel GNOIeNNE | Select B thru [ for flashing first digit, [§ thru

High signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

PXLLe CNONNN NeINls | Select K thru [§ for flashing first digit, [§] thru [§

Desired reading at | (Jo[efels ONeJeJofe! for other flashing digits. Decimal point is set

HiIn. Select digit to flash. SYdEC.Pt

Scaling method “Reading coordinates of 2 points” if selected under

Low signal input. Apply a low reference

signal to the meter.

Press A to store the low signal input in the
meter.

20.094
Apply a high reference
signal to the meter.

i In
igh signal input.

e T

Press A to store the high signal input in the
meter.

Lord 0.000080.000080.0000MR0.0000,

Desired reading at | fYee SNl Select K¢ thru g for flashing first digit, ] thru

Lo In. Select digit to flash. for other flashing digits. Decimal point is set
J MG EC.Pil

0.00000.0000[§0.0000§§6.7500

Desired reading at | fYelel SXolN Select K¢ thru g for flashing first digit, §] thru

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

SRdEC Pl

Option board dependent menu items
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Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section16.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

| 13. AC TRUE RMS VOLTS & AMPS INPUT I

23



AC voltage or current measurement utilizes the True = 5 I~ v

RMS signal conditioner board which uses precision ﬂmm\ -
circuitry to compute the root-mean-square of complex : )
waveforms from 10 Hz to 10 kHz. Accurate measure- \L E{=Vy)
T
L

maximum of each range. The input can be AC
coupled to read only the AC component, such as
ripple on a power supply, or DC coupled to read AC
plus DC. The board needs to be configured via
jumpers for the desired voltage or current range, and
for AC or DC coupling. All signal ranges are factory t
calibrated with calibration factors stored in EEPROM.

The meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. These need to be set manually. Please
see further manual sections for setup of the following features: relay output (16), analog output
(17), and communications (18).

ments are obtained with spikes up to 3 times the \

Voltage Ranges

Full Scale Input [ Counts | Jumpers
200 mV 20000 j

2V 20000 c,g,h
20V 20000 C,i
200V 20000 c, k
300V (UL) 3000 c, m
600V (not UL) 6000 c,m

Current Ranges

Full Scale Input | Counts | Jumpers

2mA 20000 l, k

20 mA 20000 b, m

200 mA 20000 a,m

5A 5000 c,d,e,m

AC or DC Coupling

Coupling Type Jumpers RANGE SELECTION VIA JUMPERS

DC coupling for AC + DC f 1. Use 2.5 mm (0.1") jumpers.

AC coupling for AC only none 2. Store spare jumpers on unused jumper post.

METER SCALING

Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
can be set for direct readout in (milli)volts or (milli)amperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.

The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
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factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.

All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters.

INTERNAL SHIELD

To reduce noise pickup inside the meter or transmitter, the
RMS board is fitted with a flexible plug-on shield. If necessary,
This shield may be removed for jumper setting, but must be
reinstalled before closing the instrument.

SIGNAL SHIELDING

_ L\ Sig High  RMS
[
Signal Source 71 Sig Low  Board

____________________________________________________

Shield around twisted pair
— Earth Ground
Shielding for noise reduction

AC RMS measurements are susceptible to signal noise. This is especially true when the instru-
ment has a wide bandwidth. To minimize noise pickup, the input signal wiring should utilize a
shielded twisted pair, and the shield should be connected to signal low at the meter, as
illustrated. If signal low is close to earth ground, such as within 2V, signal low can further be
connected to earth ground at the meter, as illustrated.
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KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu
amd Select Key

E Press Digit
Select Key

Press Value Select
A Key

Selection of signal
input type & range

Strain or ratiometric

0.2, 2, 20, 200, 660V FS

DC millivolts 2,20,200 mA, 5AFS
SEtuP 00 00 B 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (+99,999)
scale factor of 1 4-1/2 digits, counts by 10 (+20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 [ 1=Reset, 2 = Meter Hold
Rear connector inputs 1 = Function Reset 2 = Pk or Valley Disp.
1&2 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 = Tare
tied to digital ground) 1=Peak or Valley 2= Tare
False = logic 0 (5V or 1=Tare 2= Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2=1, decimal point 1 = XXX. XX
1=1,2=1, decimal point 1 = XX.XXX
1=0, 2=0, decimal point 2 = XXXX.X
1 =1, 2=0, decimal point 2 = XXX.XX
1=0, 2=1, decimal point 2 = XX.XXX
1=1,2=1, decimal point 2 = X. XXX.X
B 1 = Function Reset 2 = Display Blank
® 1=Hold 2 = Display Blank
1 = Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset

Both control inputs 1 & 2 set to 1 for selec-
tions &, B, I\, @ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-

tions 8, A1 B, B, B & B, B = Meter Reset.
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Press Menu H Press Digit 3 Press Value Select
amd Select Key Select Key V' 9 Key
000 0 [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
00 0 [ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 0 [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 0 @ Linear input
Nonlinear input scaling Custom curve linearization
Extended meter only.
00000 [ Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 [l Display batch average every readings
Display filtering Display filtered signal
BRI Adaptive filter | Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
' Moving average, 9.6 sec.
Unfiltered
dEc.Pt . . d.dddd d.ddddjdd.dddddd.dd@dddd.d@ddddd.
Dec. point selection | Decimal point flashes. | [
Press Menu H Press Digit Press Value Select
amd Select Key Select Key V' 9 Key
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Scaling method “Scale and Offset” if selected under

SCALE PRLls) GNOINK GNOINElS | Select B thru [g for flashing first digit, [§ thru g
Scale factor XeTlore [sMololere iMelelos | for other flashing digits. Select decimal point
Select digit to flash location when decimal point is flashing.
OFFst PXLls) CNOINK GNOINElS | Select B thru [§ for flashing first digit, [§ thru [g
Offset value 0.0000§0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by F]=eNg.

Scaling method “Coordinates of 2 points” if sel

ected under NS0l

i

0.000040.000080.0000

oln

Select K thru [g for flashing first digit, |§ thru [g

Low signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLls) CNOINK GNOINlS | Select B thru [§ for flashing first digit, [§ thru g

Desired reading at | SEoJelels] SNONIJe for other flashing digits. Decimal point is set

Lo In. Select digit to flash. QYdEC. P

Hi In PRIl ONeNNele GNONNN | Select B thru ) for flashing first digit, § thru [§

High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

PXLls) GNOINKE GNEINElS | Select X thru [§ for flashing first digit, [§ thru [g

Desired reading at | SEoefeld SHeJe[[e for other flashing digits. Decimal point is set

HiIn. Select digit to flash. WA EC. P

Scaling method “Reading coordinates of 2 points” if selected under

0.021 0.021

Low signal input. Apply a low reference

signal to the meter.

Press A to store the low signal input in the
meter.

i In
igh signal input.

Apply a high reference
signal to the meter.

e T

Press A to store the high signal input in the
meter.

Lord 0.00000.000080.00004N0.0000

Desired reading at | fYeII8 AXOLN Select K thru [§ for flashing first digit, |§ thru [g

Lo In. Select diait to flash. for other flashing digits. Decimal point is set
9 by REeR

0.0000§0.0000[0.0000§l§6.7500

Desired reading at | (Yol AXSl0) Select K thru [§ for flashing first digit, |§ thru [g

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

by SNl

Option board dependent menu items
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Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section16.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including JJIIER. Decimal point is set by S[=eHgt.
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14. THERMOCOUPLE INPUT

The thermocouple signal conditioner board used for temperature measurement can be confi-
gured via jumpers for 7 thermocouple types, each in a single range: J, K, T, E, N, S, R. The
meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. Display in °C or °F and resolution of 1°,
0.1° or 0.01° are user programmable. High resolution should only be used for relative readings,
not absolute readings. Although available, 0.01° resolution is not recommended for thermo-
couples. Offset adjustment is available for thermocouples and is normally set to 0000.0. If °C is
selected, entering an offset of 0273.2 will change the display to Kelvin. If °F is selected,
entering an offset of 0459.7 will change the display to Rankin.

The addition of a relay output board turns the thermocouple meter from a temperature indicator
into an on/off temperature controller. Please see further manual sections for setup of the
following features: relay output (Section 16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

Type E4 Jumper
J,K,E,N none
TR, S j
Open Indication E3 Jumper
Upscale h
Downscale i

[e7a] E4

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an
unused jumper post.

E3
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KEYSTROKES FOR SETUP

If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu

amd Select Key

Press Digit
Select Key

{391 Press Value Select

Y
D
<

A

Selection of signal
input type & range

Thermocouple

J °F J °C

Type J, °F or °C
Type K, °F or °C
Type N, °F or °C
Type E, °F or °C
Type T, °F or °C
Type S, °F or °C
Type R, °F or °C

nNi~mi=s |x
of of o o} o
T imiTmlm
N~ [m|= |~
OOOOO
o] (o] o] (2] X

r °F r°C

SEtuP
Meter Setup

00 00 [ 0.1 degree resolution
Display selection. Remote display (£99,999)
0.01 degree resolution
1 degree resolution
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Offset only for thermocouple input.
Scaling method
00 00 [l 1 =Reset, 2 = Meter Hold
ontrol inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic 0 (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1 =Tare, 2 = Reset
@ 1=0, 2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2=1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1,2=0, decimal point 2 = XXX.XX
1=0, 2=1, decimal point 2 = XX.XXX
1=1,2=1, decimal point 2 = X.XXX.X
B 1 = Function Reset 2 = Display Blank
& 1=Hold 2 = Display Blank
I 1 = Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1="Tare 2 = Tare Reset

Both control inputs 1 & 2 set to 1 for selec-
tions @, B, I, /& = Function Reset.

Both control inputs 1 & 2 set to 1 for selec-

tions®, 1 B & B [ B, B = Meter Reset.
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Press Menu H Press Digit 3y Press Value Select
amd Select Key Select Key A ICY
000 0 @ No used.
Meter Configuration 00 0 [ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at rear connector.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at rear connector.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 B Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 [l Display batch average every 16 readings
Display filtering Display filtered signal
Bl Adaptive filter | Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 § Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec. Unfiltered
PNOINN CNTlls NoIlls | Select B thru [§ for flashing first digit, § thru
Offset value 0.0000§0.0000 for other flashing digits. Use offset for display

Select digit to flash.

in Rankine or Kelvin.

Option board dependent menu items

Menu items related to alarm setup if a relay board is detected. Please see Section16.

Menu items related to analog output if detected. Please see Section 17.

Menu items related to serial communications if detected. Please see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) menu items. Please see Section 9.
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15. RTD & RESISTANCE INPUT I

RTD and resistance measurement can be configured via jumpers for four RTD types (DIN
platinum, ANSI 100Q platinum, 120Q nickel, 10Q copper) or five resistance ranges (from
20.000Q to 200.00 kQ). All ranges are factory calibrated with calibration factors stored in
EEPROM on the signal conditioner board. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
With RTDs, display in °C or °F and resolution of 1°, 0.1° or 0.01° are user programmable.

Please see further manual sections for setup of the following features: relay output (Section
16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

RTD Type or Ohms E1 Jumper

Pt100, Ni120 a e o o
Cu10,20 Q b 10 ¢ ¢
200 Q c a b c
2000 Q d ne e
20000 Q e E2

200 kQ f

Connection E2 Jumper

2 or 4 wire none

3 wire g

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.

SCALE & OFFSET SETUP

Scale is normally set to 1.0000. Scale can be used as an RTD correction when actual
resistance is other than nominal, as stated on the RTD calibration sheet. For a Pt100 RTD,
divide 100 by the stated resistance at 0°C. For example, for a 99.04 ohm RTD, scale should be
setto 100/ 99.04 = 1.0097.

SIGNAL SHIELDING

=] Sig High Ohms
_t Sig Low Board

Resistance

Shield around twisted pair

Shielding for noise reduction
200 kQ ranges and above measurements are susceptible to signal noise. To minimize noise

pickup, the input signal wiring should utilize a shielded twisted pair and the shield should be
connected to signal low and earth ground at the meter, as illustrated. Use 2-wire hookup
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RTD & RESISTANCE CONNECTION
With the appropriate jumper settings, RTD

and resistance measurements allow 2, 3 or 4- Excitation [ 1

wire RTD hookup to the J5 connector, as +Exctation | 2 T
illustrated. The meter applies a fixed excita- -Signal input [ 3 | |
tion current. +Signal input | 4

In 4-wire hookup, lead resistance is not a
factor, since different pairs of wires are used
for excitation and sensing.

In 3-wire hookup, the meter automatically -Excitation | 1 —
compensates for lead resistance by measur- +Excitation | 2 [ |:|
ing the voltage drop in one current-carrying -Signal input | 3 .
lead and assuming that the voltage drop in +Signal input | 4

the other current-carrying lead is the same.

In 2-wire hookup, the meter senses the
voltage drop across the load and both lead

wires. The effect of the lead wires can be _Excitation | 1 —
measured and subtracted by shorting out the +Evcitation | 2 ._‘

load during meter setup. The short should be -Signal input | 3 |:|
as close as possible to the load. Ambient +Signalinput | 4 |

temperature changes will still cause some
error in the readings -- the higher the lead
resistance, the greater the error.

4-wire RTD or resistance

3-wire RTD or resistance

2-wire RTD or resistance

To eliminate lead wire resistance, follow this procedure:

1. Set the InPut menu item and jumpers for the desired range

. Set CONnFG to [e]e[ekmi.

2
3. Short the two leads at the sensor end.
4

. When the display has settled, push the » key. The meter will then store a value propor-

tional to lead resistance, automatically change COnFG to [§[88fls}, and then reset. The same
result is obtained by grounding a Control Input that has been selected for Peak or Valley
(SEtuP SO0, where Y =1,2, 4, A, C).

Remove the short and connect the sensor. The meter now processes the sensor resistance
only.

If the range and associated jumpers are subsequently changed, the above procedure must be
repeated. This procedure is also available through Instrument Setup software, Revision 2.7.0
or later.
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KEYSTROKES FOR SETUP

If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

i Press Menu
emd Select Key

E Press Digit
Select Key

Press Value Select
A Key

Pt100 RTD, DIN alpha .00385, °F
Selection of signal | RTD Pt100 RTD, DIN alpha .00385, °C
input type & range Pt100 RTD, ANSI alpha .003902, °F
i@ Pt100 RTD, ANSI alpha .003902, °C
GIM=M Ni120 RTD, alpha .00672, °F
Ni120 RTD, alpha .00672, °C
Cu10 RTD, alpha .00427, °F
Cu10 RTD, alpha .00427, °C
0 to 20 ohms
Ohmmeter 0 to 200 ohms
0 to 2000 ohms
0 to 20000 ohms
0 to 200.00 kohm
SEtuP 00 00 @ 0.1°RTD or 4-1/2 digits for ohms
Meter Setup Display selection with 5-digit remote display (+99,999)
scale factor of 1. 0.01° RTD, 4-1/2 digit ohms count by 10
1° RTD or 3-1/2 digits for ohms
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method (RTD & ohms)
Scaling method Coordinates of 2 points (ohms)
Reading coordinates of 2 points (ohms)
00 00 [ 1=Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic 0 (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1 = Tare, 2 = Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2=1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1,2=0, decimal point 2 = XXX.XX
1=0, 2=1, decimal point 2 = XX. XXX
1=1,2=1, decimal point 2 = X.XXX.X
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=] Press Menu E Press Digit Press Value Select

md Select Key Select Key Yy 9 Key

SEtuP 00 00 B 1 = Function Reset 2 = Display Blank

Meter Setup Control inputs 1 & 2 ® 1=Hold 2 = Display Blank

(continued) (continued) N 1 =Peakor Valley 2 = Display Blank
B 1=Tare 2 = Display Blank

1 = Valley Display 2 = Peak Display
B 1="Tare 2 = Tare Reset

Both control inputs 1 & 2 set to 1 for selec-
tions &, 1, I, [@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-

Meter Configuration

O[0[8[8]s} Operation as a
rate of change meter.
Extended meter only.

[ Not rate of change B Rate x 10
Rate x 0.1 Rate x 1000
Rate x 1 B Rate x 10000

00000 @ Peak Display. Also selects “Peak” in

Operation of front “Peak or Valley” at connector above.

panel PEAK button Valley Display. Also selects “Valley” in

and rear connector for “Peak or Valley” at connector above.

Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare

00000 @ No auto-tare

Auto-tare selection Auto-tare

00000 RTD Ohms

RTD or Ohms wiring [ 3 or 4 wire 3 or 4 wire
Not allowed Custom curve
2-wire read 2-wire read
2-wire short 2-wire short

00000 B Unfiltered output
Filtering Alarm filtering Filtered output

00000 B Unfiltered Peak & Valley

Peak & Valley filtering Filtered Peak & Valley

00000 B Display batch average every 16 readings

Display filtering Display filtered signal

B Adaptive filter | Low adaptive filter threshold level

threshold High adaptive filter threshold level
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
00000 B Autofilter
Filtering Input signal filtering. Batch average, 16 readings
(continued) Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec.
A unfiltered
dEc.Pt d.dddd d.ddddgdd.ddd@ddd.dd@dddd.diddddd.
Decimal point Decimal point flashes
: .ddddd
selection if ohms are selected Ldddod
TEd InPut]
SCALE PRLls) CNONNN NOINEls | Select B thru [§ for flashing first digit, [§] thru g

Scale factor for other flashing digits. Select decimal point

location when decimal point is flashing.

O K
o
o
1©
(@)
N O
o
o
o
— |[@)]
s E
o
o
o
(@)

Select digit to flash
PNOINN CNTlls NoIlls | Select B thru [§ for flashing first digit, § thru
Offset value 0.0000§0.0000 for other flashing digits. Use offset for display
Select digit to flash. in Rankine or Kelvin. Decimal point location

is selected by S[SeHg.

Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section16.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/0 board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
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16. DUAL OR QUAD RELAY OUTPUT OPTION I

An optional relay board may be installed in the
meter main board at plug position P2, adjacent to
the power supply board. Four board versions are
available: 2 or 4 relays, mechanical or solid state.
Once installed, the relay board is recognized by
the meter software or PC-based Instrument Setup
software, which will bring up the appropriate menu
items for the type of board. These menu items will
not be brought up if no relay board is detected.
Menu selections for relays 3 and 4 will not be
brought up if the dual relay board is detected. All
relay boards offer a choice of operating modes: normally off or on, latched or non-latched,
hysteresis band, deviation band, alarm based on the filtered or unfiltered signal, and selectable
number of readings in alarm zone to cause an alarm.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

The @l (Alarms) key can be used to step through and view setpoints while the meter conti-
nues to make conversions and performs setpoint control. If the » (Peak) key is pressed while
a setpoint is displayed, conversion stops and the setpoint can be changed. After pressing ¢l
you have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Loc1, digit 4, must have been set to 0. To change setpoints, menu item Loc4, digit 6, must

have been set to 0.

Press Alarms
el KEY

E Press Digit
Select Key

Press Value Select
A Key

300.24

Press 4=l (Alarms)
to display Alarm 1
setpoint.

Current setpoint 1 value blinks, and
Alarm 1 LED indicator lights. Press »>
to select a digit, which will blink.

To change setpoint 1 value,
press A to change selected
blinking digits.

395.00

Press 4=l (Alarms)
to display Alarm 2
setpoint.

Current setpoint 2 value blinks, and
Alarm 2 LED indicator lights. Press »>
to select a digit, which will blink.

To change setpoint 2 value,
press A to change selected
blinking digits.

395.00

Press 4=l (Alarms)
to display Alarm 3
setpoint.

Current setpoint 3 value blinks, and
Alarm 3 LED indicator lights. Press »>
to select a digit, which will blink.

To change setpoint 3 value,
press A to change selected
blinking digits.

395.00

Press 4=l (Alarms)
to display Alarm 4
setpoint.

395.00

Current setpoint 4 value blinks, and
Alarm 4 LED indicator lights. Press »
to select a digit, which will blink.

305.00

To change setpoint 4 value,
press A to change selected
blinking digits.

K% Press el (Alarms) again. Meter will reset and display current reading.

KEYSTROKES FOR SETPOINT SETUP
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If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu E Press Digit Al Press Value Select

amd Select Key Select Key V' 9 Key

[ Relay 10n Relay 2 on

Alarm Setup for Relay state when Relay 1 off Relay 2 on

relays 1 & 2 if alarm is active. Relay 1 on Relay 2 off

detected. Relay 1 off Relay 2 off

Press B yntil @ Alarm 1 auto reset Alarm 2 auto reset

ALSEt is displayed. | Alarm latching or non- Alarm 1 latching Alarm 2 auto reset
latching (auto reset). Alarm 1 auto reset  Alarm 2 latching

Alarm 1 latching Alarm 2 latching

| 00000

Alarm operates at and
above setpoint (active
high) or at and below
setpoint (active low).

AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled

AL2 active high
AL2 active high
AL2 active high
AL2 active low
AL2 active low
AL2 active low
AL2 disabled
AL2 disabled
AL2 disabled

00000

Hysteresis mode or
band deviation mode

.5 100 [N [ O JN00 [N O OIS W IN [H (O

AL1 band deviation
AL1 hysteresis
AL1 band deviation
AL1 hysteresis

AL2 band deviation
AL2 band deviation
AL2 hysteresis
AL2 hysteresis

No deviation or hysteresis in menu.

[l After 1 reading After 16 readings
Number of consecutive After 2 readings After 32 readings
readings in alarm zone After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
[ Relay 3 on Relay 4 on
Alarm Setup for Relay state when Relay 3 off Relay 4 on
relays 3 & 4 if alarm is active. Relay 3 on Relay 4 off
detected. Relay 3 off Relay 4 off
[ Alarm 3 auto reset Alarm 4 auto reset
Alarm latching or non- Alarm 3 latching Alarm 4 auto reset
latching (auto reset). Alarm 3 auto reset  Alarm 4 latching
Alarm 3 latching Alarm 4 latching
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Y ¥ Key
B AL3 active high AL4 active high
Alarm Setup for Alarm operates at and AL3 active low AL4 active high
relays 3 & 4 above setpoint (active AL3 disabled AL4 active high
(continued) high) or at and below AL3 active high AL4 active low
setpoint (active low). AL3 active low AL4 active low
AL3 disabled AL4 active low
B AL3 active high AL4 disabled
AL3 active low AL4 disabled
B AL3 disabled AL4 disabled
@ AL3 band deviation AL4 band deviation
Hysteresis mode or AL3 hysteresis AL4 band deviation
band deviation mode AL3 band deviation AL4 hysteresis
(see Glossary) AL3 hysteresis AL4 hysteresis
@l After 1 reading After 16 readings
Number of consecutive After 2 readings After 32 readings
readings in alarm zone After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading

dEU1H OO0 ONJlelel (MOJelsl8 | Select Be thru [§ for flashing first digit, [§] thru g
Alarm 1 0.0000[0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEUZ2H
entered.
Alarm 2
hysteresis
DEU1b PNLNLs) ONLlls BMelslY | Select B thru [§ for flashing first digit, [§] thru g
Alarm 1 band 0.000080.0000 for other flashing digits. Alarms will activate
deviation Select digit to flash. above and below the setpoint by the value
entered and will deactivate in the middle of
DEU2D the band.
Alarm 2 band
deviation
dEU3H PNLLls) [ONLls BMJollY | Select B thru [§ for flashing first digit, [§ thru g
Alarm 3 0.0000H0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEU4H
entered.
Alarm 4
hysteresis
DEU3b ONOLL]s) ONLlNs BNl | Select B thru [g for flashing first digit, [§ thru g
Alarm 3 band 0.0000[0.0000 for other flashing digits. Alarms will activate
deviation Select digit to flash. above and below the setpoint by the value
entered and will deactivate in the middle of
DEU4D the band.
Alarm 4 band
deviation

40




17. ANALOG OUTPUT OPTION I

An optional analog board may be installed in the meter at rear panel jack position J4, adjacent
to the signal conditioner board. Once installed, this board is recognized by the meter, which
will bring up the appropriate menu items for it. These will not be brought up if an analog output
board is not installed.

The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line.
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is
selected at the connector. Unipolar 4-20 mA or 0-20 mA current is selected in software.

UNIPOLAR CONNECTIONS

4-20 mA or 0-20 mMAQUTPUT 1| [xm

0-10V OUTPUT 2| I

ISOLATED GROUND 3| I
BIPOLAR CONNECTIONS

REFERENCE or RETURN 1] [Im

-10V to +10V OUTPUT 2| @I

N/C 3D

Unipolar current of voltage: Jumper a
Bipolar -10 to +10 voltage: Jumper b

The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low
displayed reading An Lo. The high analog output (20 mA, OV or 10V) may be set to corres-
pond to any high displayed reading An Hi. The meter will then apply a straight line fit between
these two end points to provide an analog output scaled to the meter reading.

KEYSTROKES FOR SETUP
If the MENU B= key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

IS Press Menu

Press Digit Select Press Value Select
amd Select Key Key Key

@ 0-20 mA current output

Analog Output Setup. | Analog output signal 0-10V voltage output

Press = until AnSEt | selection. 4-20 mA current output

is displayed (requires -10 to +10V voltage output

analog output board) [ 00 [ Analog output unfiltered
Analog output filtering. Analog output filtered

Low displayed value
for 0 mA, 4 mA, 0V, or

0.000040.000080.0000
0.00000.0000

Select ¥ thru g for flashing first
digit, [§ thru [§] for other flashing

put

Select digit to flash. digits. Decimal point location is
-10V output J fixed by selection.
0.0000[§0.00000.0000 Select X8 thru ] for flashing first
High displayed value | RXJe8] SOl digit, [§ thru [§] for other flashing
for 20 mA or 10V out- | gglect digit to flash. digits. Decimal point location is

fixed by [J]SeH i selection.
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18. SERIAL COMMUNICATION OPTIONS I

A variety of optional serial communications boards may be connected to the meter main board
at plug position P13 (middle position). These include RS-232, RS-485, RS-485 Modbus, USB,
and USB to RS-485.

Both boards feature dual connectors, which are wired in parallel to allow daisy chaining of
addressable meters. Three serial communication protocols are : Custom ASCII, Modbus RTU,
and Modbus ASCII. Multiple meters on the same serial communication line requires RS485 or
RS485-Modbus boards. The USB to RS485 converter replaces the RS485 board in one of the
meters to provide a direct USB connection to a PC or PLC without an external converter.

LOADING USB AND USB/RS-485 DRIVERS

Using a USB cable with Type A and Type B connectors, connect the meter to the computer.
The computer will display “Found new Hardware” followed by “Welcome to the ‘Found new
Hardware Wizard’ ”. Follow the instructions for installation from a CD

When the installation is complete, use the Device Manager to determine the Com port
number. To get to Device Manger, go to Control Panel, click on System, click on Hardware tab
and then click on Device Manager. Go down the device list and click on Ports (COM & LPT)
and USB serial port (com #). Note the com port # for use with communications to your
Laureate meter and exit Control Panel

If you need to change the Com port, right click on USB serial port (com #), then click on
Properties, Port settings and Advanced. Change port to the desired number and click OK. And
exit Control Panel.

BOARD SETUP VIA JUMPERS

USB Board No jumpers required

RS232 Board
g - Normal operation.
h - Slave display operation to RS232 from another meter.
J - Pull-up resistor on RTS line.

—ETEQR

RS-232

Note: The board is shipped with jumpers g and j installed.

RS232 Board Rev J

e - Normal operation.

f - Slave display operation to RS232 from another meter.
. ) 232

g - Pull-up resistor on RTS line.

Note: The board is shipped with jumpers e and g installed RS-232 memfmgm S

RS485 and RS485-Modbus Boards
Full Duplex Operation manm wbn

b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.

Modbus
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Half Duplex Operation

madm
b & e - bias jumpers installed on 1 board. . aCadm
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs. nem ufam
Note: The boards are shipped with no jumpers installed. RS-485

b d
RS485 Rev J and USB/RS485 Boards mdm mDuCuuCn

Full Duplex Operation
b & d - Installed on last meter in long cable run.

RS-485

Half Duplex Operation

a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Note: The boards are shipped with no jumpers installed. | sp/rRs-485
mam mbuCundn

KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu H Press Digit Select Press Value Select

amd Select Key Key V' 9 Key

[ 000 @ Send unfiltered signal

Fixed Parameters: | Output filtering Send filtered signal

noparty 000 @ 300 baud

1 stop bit Baud rate 600 baud
1200 baud
2400 baud
4800 baud
9600 baud
B 19200 baud

| 000 60 Hz 50 Hz
Output update rate @ Line frequency Line frequency

0.28 sec 0.34 sec
0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
4.5 sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
B 36.6sec 43.5 sec
[ 72.5sec 97 sec
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Press Menu
amd Select Key

Press Digit Select
Key

{331 Press Value Select

A Key

Serial Setup 2

!

000 @ No line feed after carriage return
Line feed Line feed after carriage return
0000 @ No alarm data
Alarm data with readings Alarm data with reading
0000 [ Continuous data output
Control of data output Data output on ASCII command only
0000

Meter address with Custom
ASCII protocol

Select &thru %‘or addresses 1 thru 15.
Select [0} thru [@ (with decimal point) for
addresses 16 thru 31.

00000 @ Full duplex
Serial Setup 3 Half or full duplex Half duplex
00000 [ Standard continuous mode
Special start & stop char. Special start & stop characters
00000 B Normal RTS
RTS mode Single transmission
00000 [ Only at end of all items
Termination characters At end of each item
00000 B Reading
Serial Setup 3 Data sent in continuous Peak
(continued) mode Valley
Reading + peak
Reading + valley
Reading + peak + valley
SEr 4 @ 1sec
Serial Setup 4. Modbus ASCII gap timeout 3 sec
5 sec
10 sec
!m @ Custom ASCII
Serial protocol Modbus RTU
Modbus ASCII
| 000 @ None, 2 or more stop bits
Parity Odd, 1 or more stop bits
Even, 1 or more stop bits
000 000 000 247
Modbus Address. | Select digit to flash. Select [§ through [ for flashing digit.

Appears only if the
Modbus protocol is
selected.

Address range is 1 to 247.
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19. EXCITATION OUTPUT & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (85-264 Vac) and to the low voltage power
supply (12-32 Vac or 10-48 Vdc).

0000 ooo
bcd ef
a hg
pg 00O
Excitation output Jumper locations
b d e
5 Vdc £5%, 100 mA max b,d, e E B Bl BRE RN
0 b d f
10 Vdc £5%, 120 mA max b,d,f EEEE EEBE
24 Vdc £5%, 50 mA max c c
HE BB D BEER BN

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. (See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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20. INSTRUMENT SETUP VIA PC

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download 1S2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.
2) Meter to be set up.

3) RS232 board in the meter. This board can be =]
used for meter setup, then be removed. s 2 At
4) RJ11-to-DB9 RS232 cable to connect the meter | =

and PC (see Section 1, Ordering Guide). RJ11-to.DB9 RS.237 cable
5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => IS2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.

| . Extobieh CommmunicaticmsoP STES) =10xf
Com Forts Baud Hate Frotocol Select Instrument and Serics
® Com 1 300 & Custom ASCTT Panel Meter Transmitter
C Com2 800  Modbus RTU
: Zmi 1200 " Maodbus ASCIT ® DPM " Analog Tnput
om C 2400 Hulp 5
ooz e - " Weight Meter
. T
1 Com & & 9600 i " Counter/Timer ' Counter/Timer
O Com T 19200 None Back
© Com 8
O Com 9 Quit Series
L " Series 1
Other Com Port  Series 7
ETies
| Wait while pting to establish
Back it

Meter Type
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=loi x|

Input+Display| _ Scaling | Filter | Relay Alanms | Communication] Analog Out | Lockouts

C BASIC - 5ig Cond Option Relay Option Comm Option Analog Dption
Option
® EXTENDED Bpards | OGN = | ||[Relay Board =] ||[RS232 Board =] || [Nane =l

=10l x|

Filter ims | Enmmunicalim‘, Analog Dut T Lockouts

Input+Display Scaling

rAlarm 1

Setpoint 1
“ +010000. ‘

rAlarm 2

Setpoint 2
“ +020000. |

Deviation 1 Deviation 2
rSignal Input ( +000000. “muuuuu
Mode Range Custom Curve Rate 50/60 Hz Line Freq
| Alarm 1 Source Alarm 2 Source
[ocw =l 0.2e | || |pisabled =] ||[visabled =[] Je0 Hz j‘ “Fﬂm " J—‘ “Fﬂm . JT
T Te
~Display Alarm 1 State Alarm 2 State
Resolution Display Filter Decimal Point Peak Button Action 7—Auto Tare “ High Active v “ High Active v
“4. 5 Digits j “Filtered LI ’]ddddd. j—‘ “Peak d““nisahled ;I Relayl Alrm State Relay2 Alvm State
’V Active On. ' ’V Active On '
Deviation 1 Type Deviation 2 Type
’V Band Deviat" nJ ’V Band Deviat" nJ
r Control Inputs Alarm 1 Type Alarm 2 Type
Control Input A ------------ Control Input B -------——----— Both Ctrl A, B ’V T J ’V =
hMgter Reset Meter Hold ColdReset =] on-Latching on Latching 7|
Alarms 1,2 No. Rdgs to Alarm:
’VI 1 Reading v—‘ [~ Mo Deviation in Memu
Main Menu | Main Menu

SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

e The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading 0’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

2900. 4 |
2875,

T2 e e e e o
2850,
2825. 1Y I T | N
2800.

512 4 - - e
2775,
2750.

L R R LLLCCEEPPEEERPREEREPE © | 1 & R L R
2725,
2700. 1]

2725 2750, 2775, 2800 2825 2850, 2875
Print Save | Pause | Continue | New Scale End
Plot Graph
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e The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

e The Jumpers pull-down menu provides =T
jumper positions for the various meter boards,
duplicating information in this manual.

e The Calibration pU”-dOWI’] menu allows N Sy ——

easy calibration of voltage and current ranges | faik [Dested | Curent et e et o
for the DC, load cell, and AC RMS signal [tvbc o |- Frio [ Fros | ot
conditioner boards. The PC first recognizes +0uo0z FFFB FREZ 0002

-00002 FFE2 FFFB +00000

the type of board, then prompts you to apply
specific jumpers and calibration signals. Press
Ready to take a reading. Press Repeat to take
more readings. When you have decided on

FLECELERELAR’

which reading to accept, press on the number sop |
1 through 10 of that reading. Additional cali-
bration software is available online. MENUKEY |S [1 ]2 (3[4 |5
InPut d C 1
METER SETUP WITH AN UNCONNECTED PC SEtuP 0 0 0 0 O
Instrument Setup software is also of benefit when the C_““FiG 0j0j0 0|0
PC is not connected to a meter. Upon launching the |ZLEr 001116
software, click on None for Communications, then on |-2€cPt d/d d./dd
DPM and Series 2. Click on File => Default Setup to SCALE o jojoj1)0
retrieve a default setup file from disk, or on File => Open OFFSt o000 0
Setup to retrieve a previously saved setup file from disk. gg; 0 g ? '1]
To enter new setup information, click on View => Setup, | Loc1 0 0 0O D O
then make your screen selections as if you were | Loc2 0D 0 1 0
connected to a meter. Tabs will be grayed out if you | Loc3 0 0 0 O
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under

Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
k=) key, and the seven data columns correspond to values entered via the » and A keys.

Click on any step in the sequence to bring up a detailed help window.

Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.

Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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21. CUSTOM CURVE LINEARIZATION

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curve-

fitting algorithm uses quadratic segments of Tank Volume from Pressure
varying length and curvature, and provides at the Bottom of the Tank

diagnostics to estimate curve fitting errors.
The program is self-prompting, avoiding the
need for a detailed printed manual. This
manual section is only intended as an intro-
duction and get-started guide.

PREREQUISITES

1)
2)
3)

4)

5)

PC-compatible computer with an available Com 1 or Com 2 RS232 port.
Extended meter.
An RS232 board in the meter. This board can be

used for meter setup only, then be removed. 5 ;
An RJ11-to-DB9 RS232 cable to connect the s 2 UDGDU uﬂﬁ
meter and PC (see Section 1, Ordering Guide). 5

Curve.exe software (downloadable from the web

at no charge). RJ11-t0-DE9 R5-232 cable

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the l= key to get to , then
set the entry to [lE. Set the meter address to 1. To do so, press the I key to get to
B, then set the entry to [eFEl. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.

You will be given the choice to enter your data in one of four modes:

1)

2)
3)

4)

Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.

2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.

Equation entry mode, where the coefficients of a polynomial Y = K1X*"P1 + K2X*P2 +
K3*XAP3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.
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You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter 0 and 0 for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.

Position of the decimal point from 6=X.XXXXX, 5= XX. XXX, 4=XXX. XXX, 3=XXXX.XX,
2=XXXXX.X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the Im key to get to [Sf]3la€, then set the fifth digit to either [§
(normal linear operation) or to M (custom curve operation). This fifth digit will only be
displayed with an Extended meter.

FILES USED OR CREATED BY CURVE.EXE
1) *RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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22. METER CALIBRATION

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatiie memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibra-
tion, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.
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23. SPECIFICATIONS

Meter Display

TYPE oo, 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
G0l Red or green
RaANGE.. e i -99999 to +99999 and -99990 to +99990
A to D Conversion
Technique (Pat.5,262,780).......cccooiieeiee e Concurrent Slope™
Read Rate ......cccooiiiiiiii e, 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate ...........ooovviiiiiiiieeeee e, 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate .........ccoooiiiiiiiiiiee e 3.5/s at 60 Hz, 3/s at 50 Hz
Noise Rejection
CMV from DC IO B0 HzZ......oooeeeeieeeeeeeeeece e Withstand 250Vac
Dielectric strength..........cccoooiiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMRrom DCtO B0 HZ ... 130 dB
NMR at 50/60 Hz........ooeeeieieieeeeeeee e 90 dB with minimum digital filtering
Control Inputs (CMOS/TTL levels, logic 0 = tied to digital ground, logic 1 = open)
THOI INPUL ... Logic 0 holds display and outputs
[ Peak or Valley input .............cooeviiiiiiiiiiiiiiiiiiieeieeeeeeeeeeeeee Logic 0 displays peak/valley value
[ Tare iNPUL ...t Logic 0 offsets input value to zero
[ Tare RESEt ....coovviiiiiiiiiiiiiiiiieeeeeeeeeeeee Logic O resets Tare value to zero
T RESEtINPUL.....cciiieee e Logic 0 resets all meter functions
/ Function Reset input ..., Logic 0 resets peak values and alarms
/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
/ Display Blank input.............oooiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeee Logic 0 shuts off the display
Power Requirements
Input Voltage rating (standard)......... 85-264 Vac or 90-300 Vdc (DC range not UL approved)
Input Voltage rating (low voltage option) ............cccceeiiiiiiiiiiiiiiccieee, 12-32 Vac or 10-48 Vdc
POWEr LiN€ FIrEQUENCY .....eeiiiiiiiiiiiiiiiiieitiititeteeteeeeeeeseeeees et esessessessneenne DC and 47-63 Hz
Power Consumption, MaX ..........ooouiiiiiiii i e e e aanns 5 Watts

Excitation Outputs

Voltage & Current Levels (jumper selectable) ...........cccccvvvvvveieennnnne. 5 Vdc 5%, 100 mA max
10 Vdc £5%, 120 mA max
24 Vdc = 5%, 40 mA max

Excitation OUIPUL RIPPIE ......oeeniieee e 100 mVp max
Isolation from power and OULPULS ..........ooiiieiiiiee e 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to SigNal COMIMON .........oiiiiiiiiiiii e 50 Vdc

Input Types, Ranges, Resolution, Error at 25°C
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DC Volts Thermocouple (0.1°, 1° resolution)
Range Resol. | Resistance | Error Type Range Error
200.00 mV | 10 uVv 1GQ J -210to 760°C |.01% FS £0.09°C
2.0000V | 100 pVv 1GQ 0.01% -347to 1400°F |.01% FS +0.16°F
20000V T my o TOMA ) of FS 244 10 1372°C |.01% FS £0.10°C
200.00 V 10 mV 10 MQ +2 cts K . . .
3000V 100 mV 10 MQ -408to 2501°F |.01% FS +0.17°F
0 to 400°C .01% FS +0.03°C
DC Amps T 25710 0°C  |.01% FS +0.20°C
Range Resol. |Resistance| Error 32to 752°F |.01% FS +0.05°F
-430 to 32°F |.01% FS 1£0.36°F
2.0000mA | 0.1 pA 100 Q 0.01%
20.000 mA 1 uA 10 Q D E -240 to 1000°C [.01% FS £0.18°C
200.00mA | 10 pA 10 fé 'Ztss ~400 to 1830°F |.01% FS +0.32°F
5.000A | 1mA | 001Q |~ N | 245101300°C | 01% FS 0.10°C
-410 to 2370°F | .01% FS +£0.17°F
True RMS Volts (0% to 100% of Full Scale,
0 Hz and 10 Hz to 10 kHz, crest factor 3.0) s -46 to +1768°C |.01% FS £0.12°C
-51 to +3213°F | .01% FS +0.22°F
Range Resol. | Resistance | Error N 3
R -45t0 1768°C |.01% FS £0.17°C
200.00 mV | 10 pVv 22 MQ -49 to 3214°F |.01% FS +0.31°F
2.0000V | 100 pVv 22 MQ 0.1%
20.000 V 1 mV 1 MQ of FS | RTD (0.01°, 0.1°, 1° resolution)
200.00 V 10 mV 1 MQ
Type Range Error
600.0 V 100 mV 1 MQ 2V
Pt 100Q | -202 to 850°C |.01% FS +0.03°C
True RMS Amps (0% to 100% of Full Scale, | .00385 | -331to 1562°F |.01% FS +0.05°F
0 Hz and 10 Hz to 10 kHz, crest factor 3.0 R
) [ pt100q | 202t0631°C | 01% Fs 10.04°C
Range Resol. | Resistance | Error .003925 | -3311to 1168°F | .01% FS +0.07°F
2.0000mA | 0.1 pA 100 Q 0.1% Ni 120Q | -80to 260°C |.01% FS £0.05°C
20.000 mA 1 pA 10 Q 01; FSO .00672 | -112to 500°F |[.01% FS +0.09°F
200.00mA | 10 pA 1Q
m a Cu10Q | -9710260°C |.01% FS 0.05°C
5.000 A 1 mA 0.01Q 20 mA .00427 | -143to 500°F |.01% FS +0.09°F
Resistance Measurement Ratio, Potentiometer Follower, Strain
Range Resolution Error Range Resol. |Resistance| Error
0-20.000Q 1 mQ 200.00 mV 10 Vv 1GQ 0.01%
0-200.00Q 10 mQ 0.01% 2.0000 V 100 pVv 1GQ of FS
0-2000.0Q 100 mQ of FS 20.000 V 1mV 1 MQ 12 cts
0-20000 Q 1Q +2 cts
0-200.00 kQ 10 Q

Load Cell Input
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Range Resolution Resistance | Zero Range | Span Range Error

20.000 mV 1uVv

50.000 mV 2.5 uVv o

100.00 mV 5V 1GQ '93333;0 0 to +99,999 0'012/"0?2 FS

250.00 mV 12.5 uv -

500.00 mV 25 uv

Thermocouple Accuracy
SPAN TEMPCO ..o 0.003% of reading/°C
0.0015% of reading/°C for load cell meter
W= (o T =Y 1 0] o Toto J PSPPSR 0.2 uv/°C
Reference JuNCioN ACCUFACY ........uuuiiiiiiiiieeiice e 1°C, 10°C to 40°C
Dual & Quad Relay Options

Power to Relay Option ..........ooooiiiiieiiee e Powered by meter
Setpoint Setup......ueeiiie Via front panel pushbuttons or RS232/485
Update Rate ........coooiiiiiieeeee e 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (Min).............eeeeeiiiiiiiiiiiee Display update rate
Input Signal (selectable)..........cooooieiiiiiiiiiiii e, Filtered or unfiltered input signal
Actuation Modes (selectable)...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status Indication ..., 2 or 4 red LED lamps
Status Indication Setup (selectable)....................... Lit when output is ON or OFF, or disabled
Form C, SPDT Relay Output:

AC RALING et 8A @ 240 Vac
D L3 = 1] o N 8A @ 24 Vdc
Isolation rating between signal common and contacts .............ccccceeeviiiiiiiiiiie e, 250 Vac
Insulation dielectric strength between signal common and contacts ...,
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Form A, SPST Solid State Relay Output:

AC RAUING ..t 130 mA @ 140 Vac
DC RALNG....uiiiiiieeeeeee et e e e e 130 mA @ 180 Vdc
Isolation rating between signal common and contacts ............cccccoeeevieiiiiiiiciien e, 250V ac
Insulation dielectric strength between signal common and contacts ................cveiiiiiiiins
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

Analog Output Option

Power to Analog Output Option.........ccoooiiiiiiiiic e Powered by meter
OULPUL LEVEIS ... 0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Voltage Compliance, 0-20 mA Output...........oooiiiiiiiiiiieeeee e, 12V (0-600 Ohm load)
Current Compliance, 0-10V, -10 to +10V Output.............ccceee. 2 mA (5 kOhm or higher load)
ACCUIACY ...eveiiiiieeiiiiiiiiiee e Meter input accuracy £0.02% of full scale analog output
RESOIULION .. nesnnee 16 bit (1 part in 65,536)
ReESPONSE TIME ... e e 50/60Hz update rate
Scaling of Reading for Zero Output...........ccooiiiiiiiii e -99,999 to +99,999



Scaling of Reading for Full Scale Output.............coooiiiiiiiiii e, -99,999 to +99,999

Isolation rating between signal common and analog output...............cooiiiiiiiiiineene, 250V ac
Insulation dielectric strength between signal common and analog output............ccccceeiine.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
OUtPUL TYPES ..o RS232, RS485, RS485-Modbus, USB
Power to Interface Oplion..........oooveeiiiii e Powered by meter
RSA8E WIFING ..ttt nnnsennes Half or full duplex
Baud Rates ...........euviiiiiiiiiiiiiiiieeeeeeeeeeee 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols ...........cccccceiiinneees Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
SIGNAI LEVEIS ... Meet RS232, RS485 or USB
Connectors....... USB, Single RJ11 (RS232), two RJ11 (RS485), two RJ45 (RS485-Modbus)
Isolation rating between signal common and serial 1/O ............ccccooeiiiiiiiiiiiiiiee e 250V ac
Insulation dielectric strength between signal common and serial /O ...,
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Environmental
Operating TEMPEFAUre ..........uuiiiee e 0°Cto 55°C
Storage TeMPErature .......coooo i -40°C to 85°C
Relative Humidity ...........ccoooviiiiii, 95% from 0°C to 40°C, non-condensing
Case.....ooeeveiiiiiis NEMA-4X (IP65) from front when panel mounted (not verified for UL)
SNOCK e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ........ccooeeviiiiii, 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 24. GLOSSARY OF TERMS |

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched p—
An alarm which stays actuated until reset. Setpoint + ON ™
- 1000| =EtPOINt - *
Latched alarms can shut down machinery or
a process when an operating limit has been hY
exceeded, or maintain an alarm condition K
until acknowledged by an operator.

OFF ON ™

er Reading

Alarm, Non-latched
An alarm which changes state automatically T
when the reading rises above a specified limit Setpoint .~ ON
and changes back automatically when the
reading falls below a limit.

Autofilter A selectable digital filter mode which auto- OFF OFF

matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Meter Reading §

NON-LATCHED ALARM

Time

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus
protocol, which is also offered with the meters.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
Setting up a passband around a setpoint is often used for component testing.
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Deviation limits are programmed by entering _ . .

menu item dEU1b for Alarm 1 and dEU2b for |g50/ 78 .

Alarm 2. The deviation band will be equal to |;5g0| P25 g e O,

two limits. 950 :ilss. *e .. .e POy o
Display Blank A rear panel input which blanks the display g .o’ Setpoint = 1000

when the input is tied to logic ground by a § Deviation limit = 50

switch or OV is applied (logic level true). The Deviation band = 100

Parts

meter display will light when the input is
open or is held at +5V (logic level false).

Extended Meter

Full Scale

A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of
change from successive readings.

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset

Ground Loop

Jumper

A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.

A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure signal conditioner boards for
specific signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.

Hysteresis Band

A band which controls relay action sym- Heater Heater Heater
metrically around a setpoint. The relay 1050 ~OFF A~ OFF A OFF
closes (or opens) when the reading goes \ / / \

; e i Heéter \ Hegter\ Heater
above the setpoint plus one hysteresis limit, [1000 BN ON oN -
and opens (or closes) when the reading | g55| \ ! \ \'..-"
falls below the setpoint less one hysteresis | o |: o '
.. . . < Setpoint = 1000
limit. A narrow hysteresis band is often | =3 Hysteresis limit = 50
used to minimize relay chatter around a | & Hysteresis band = 100
setpoint due to electrical noise or signal .

feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump
when the tank level has reached an upper limit. The hysteresis band will be
equal to two hysteresis limits.
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Menu Mode

Meter Hold

Modbus

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving Average Filter

Offset

Peak Display

A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milli)amps, offset is 0.

The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Process Signal

A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.

Rate of Change Meter

Reading

A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.
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Remote Display
A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter

Reset

displays rESEt.

There are three types of Reset:

= Peak and Valley Reset. Achieved by simultaneously pressing the RESET

and PEAK keys.

= Latched Alarm Reset. Achieved by simultaneously pressing the RESET and

ALARMS keys.

= Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII

command. rESEt is displayed briefly.

RS485 Half Duplex
Serial communications implemented with two wires, allowing data transmission

in both directions, but not simultaneously.

RS485 Full Duplex
Serial communications implemented with four wires, allowing data transmission

Run Mode

Scale

Scaling

in two directions simultaneously.

The normal operating mode of the meter, where readings are taken, as

opposed to the menu mode.

A constant multiplier used to go from A/D
converter counts to displayed counts. This is
the slope term m in the straight line formula y
= mx + b, where y is the displayed reading in
counts, m is the scale factor, x is the
measured reading in counts, and b is the
offset. For direct readout in (milli)volts or
(milli)amps, scale is 1.

The process of setting scale and offset so
that the meter reads properly in engineering
units (such as psi).

Scaling, Coordinates of 2 Points Method
A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
then applies a straight line fit. The decimal point is set by the separate dEC.Pt

menu item.

Scaling, Scale and Offset Method
A scaling method where scale and offset are entered manually.
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o Full span -29,999 to 99,999

High input,
high reading

Low input,
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Offset b

0 Counts x from A/D converter
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Scaling, Reading Coordinates of 2 Points Method

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

Setpoint A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the

setpoint.
Span The number of counts corresponding to a given signal range.
Tare A rear panel input which causes the display to be set to zero when the input is

momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Zero When used with process meters, zero is an adjustment so that a given low
transducer output reads zero on the meter. Zero is adjusted by programming
offset.
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25. WARRANTY

Trask Meters warrants its products against defects in materials or workmanship for a period of
one year from the date of purchase.

In the event of a defect during the warranty period, the unit should be returned, freight prepaid
(and all duties and taxes) by the Buyer, to the authorized Micron distributor where the unit was
purchased. The distributor, at its option, will repair or replace the defective unit. The unit will be
returned to the buyer with freight charges prepaid by the distributor.

LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from:

1. Improper or inadequate maintenance by Buyer.

2. Unauthorized modification or misuse.

3. Operation outside the environmental specifications of the product.
4. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is
expressed or implied. Micron specifically disclaims the implied warranties of merchantability
and fitness for a particular purpose.

EXCLUSIVE REMEDIES

The remedies provided herein are Buyer's sole and exclusive remedies. In no event shall
Micron Meters be liable for direct, indirect, incidental or consequential damages (including loss
of profits) whether based on contract, tort, or any other legal theory.

For Technical Assistance please call ~ Trask Instrumentation Inc.
414 West Poinsett St.
Greer, SC 29650
Ph: 864-848-3993
mike@traskinst.com
www.traskinstrumentation.com
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